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INTRO

Yes, these are the  
University of Akron's  
new Brand Guidelines, 
and yes, they're yours  
to dig into.

This document should 
serve as inspiration 
and a set of guardrails 
to ensure that all UA 
communications and 
content feel on-brand, 
authentic, attention- 
grabbing and yes, easy 
to use.
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HOW TO USE THIS GUIDE

CONTACT 

If you have any questions about how 
to use the brand guidelines, where to 
find elements, or any other concerns 
regarding The University of Akron  
brand, please contact:

Matt Schafer 
mschafe@uakron.edu

This document is intended for those who are creating marketing 
materials for The University of Akron. Following these guidelines 
will maintain consistency and brand recognition, but they are not 
intended to restrict expression. They are meant to inspire and clarify, 
to unify and define, as we bring this brand to life together. 

This is a living document, meaning that elements outlined here are 
subject to change.

Please use good judgment in all creative executions and strive to 
use the brand effectively, using this guide as a tool.

TOOLKIT

To ensure an iconic and recognizable 
brand, as well as ease of use for all who 
might work on it, we have developed a 
brand toolkit as an extension of these 
brand guidelines.

Download toolkit
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BRAND 
PLATFORM
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BRAND POSITIONING

BRAND PILLARS

BRAND PERSONALITY

AMPLIFYING AMBITION IN EVERY ZIP

CONFIDENT  /  INDUSTRIOUS  /  COMMITTED  /  INTENTIONAL  /  GENUINE

STRATEGY  
ON A PAGE
Our brand is built on a foundation  
that defines, grounds and connects 
all messaging, visual expressions  
and experiences. We call this the  
Brand Strategy. It’s a framework  
that acts as a North Star for all  
branded communications and 
expressions. It’s who we are, what  
we stand for and how we show  
up to our audiences. 

Brand Platform / Strategy on a Page

OUR PLACE

A Doorway  
to What  

Comes Next

OUR COMMUNITY

A Community  
of Goal-Getters

OUR SPIRIT

Giving 
Everything for 

Every Zip

OUR OUTCOMES

Activating  
Our Impact
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AMPLIFYING 
AMBITION IN 

EVERY ZIP
This place has always been about creating an environment for 
countless students to shine. It’s about more than our ability to 
provide access to internships and experiences. It’s the ability to 

make personal connections, the pouring in of support and how we 
instill confidence into each and every Akron Zip. So, when they add 

a pinch of their own self-made conviction, no goal is off limits. 

BRAND 
POSITIONING
The brand position is a phrase that  
captures the heart of the strategy in  
one thought. It is the concept from  
which the rest of strategic and creative 
thinking stems. The brand essence  
is never explicitly articulated in 
communications, but audiences  
should feel it. 

Brand Platform / Brand Positioning



The University of Akron Brand Guidelines 8

BRAND PILLARS
The brand pillars distinguish The University 
of Akron from the competition and reinforce 
the brand positioning. These pillars take the 
form of four differentiating strengths and 
communicate who we are, what we do and 
how we do it. 

Activating Our Impact
Zips are equipped to step up and stand out. From the experiences 
they receive and the pouring in of support, they enter the world  
ready to take on and achieve whatever they choose. 

A Community  
of Goal-Getters
Zips show up ready to work, and stay focused. We never shy away 
from a challenge. We’re determined — no matter the target, we’re 
driven to go after it. 

Giving Everything  
for Every Zip
Whether inside the classroom, via tutoring resources and  
classmates cheering them on, or outside the classroom through  
co-ops, student orgs, donor support and community projects —  
all Zips are given the support they need to grow. 

A Doorway to  
What Comes Next
Here transformation is inevitable. We’re not weighed down by change; 
we’re excited by the possibilities it presents and driven  
to lead our region into its next era. 

Our Spirit

Our Place

Our Outcomes

Our Community

Brand Platform / Brand Pillars
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BRAND PERSONALITY
The brand personality is composed of the traits and characteristics  
that set The University of Akron apart from other institutions. It  
represents how the core values, institutional position and attitudes  
come to life. Tone words can be expressed verbally (through copy)  
and visually (through design). 

Confident

We know we can accomplish 
anything we put our minds to.

Industrious

We can turn anything into the 
boost we all need to spring  
into action. 

Committed

We’ll do anything to see our fellow 
Zips succeed. 

Intentional

We’re here to get things done — 
for ourselves and those we impact. 

Genuine

We value authenticity, so we tend  
to tell it exactly how it is. 

Brand Platform / Brand Personality
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CREATIVE 
RATIONALE
Every brand has a story and a perspective. 
Here, we curate and craft language that 
tells our story in a way that is unique to 
The University of Akron. We start with a 
rationale. This is a written articulation that 
expresses the UA experience, establishes a 
brand voice and sets up brand themes. This 
is an internal-facing expression, but it can  
be used to inspire external messaging. 

There’s a formula for all great things. 
Always has been. Always will be. 
And it’s pretty simple, really. 
One part optimism.  
Plus equal part ambition. 
And the opportunity to show  
the world what you've got. 

MORE YES.

Brand Platform / Creative Rationale
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BRAND 
MESSAGING
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BRAND VOICE
The brand voice is the way our brand 
personality comes to life in written 
communications. While the brand voice 
should remain consistent, the tone can  
shift depending on author, context and 
medium. For example, the tone of a letter 
from the president would be different  
from a social media post. 

Brand Messaging / Brand Voice



The University of Akron Brand Guidelines 13

OTHER HEADLINE EXAMPLES

Can college be affordable, 
accessible and worth it?  
Yes. Yes. Yes.

Put that Esq. next to my name.

Give yourself a little more yes.

The world needs more yes.

It’s incredible what a chance  
can give you.

Maybe we can reinvent  
the wheel?

WRITING 
HEADLINES
Headlines should be short, eye-opening 
and engaging. They should draw in our 
audience to dive deeper, to think differently 
and to act. Always consider the medium and 
placement when writing headlines to ensure 
they fit appropriately. Headlines should 
inspire optimism, intrigue or action. They 
can live as standalone statements, questions 
or thought starters that are paid off with  
sub copy. 

Brand Messaging / Writing Headlines



The University of Akron Brand Guidelines 14

Your Name Would 
Look Really Good With 
RN Next to It. 
 
WHY NOT? OUR NURSING PROGRAM IS ONE 
OF THE BEST IN THE REGION.  
 
The best way to start your nursing career is to dive right in. Get immersed in hands-on learning 
and internships with leading medical providers right from the start. See how a degree from our 
School of Nursing is within reach. Get to Akron and go. 

WRITING 
SUBHEADS AND 
BODY COPY
Subheads can be paired with headlines to 
provide context or additional information. 
These allow headlines to be shorter and 
open-ended to maximize engagement. 
Subheads should be short and to the point 
to succinctly pay off the headline. 
 
Body copy is any long-form copy that exists 
outside of a headline or subhead. This can 
mean a paragraph on a brochure, web 
copy, a long-form video or radio script, an 
informative moment on a print ad, etc. For 
best practices, lead readers into any long- 
form writing with a “hook” — a provocative 
or inviting first sentence or two. After that, 
make sure that your body copy is succinct, 
well-paced and free of any run-on sentences 
or overly clunky or verbose language.

Brand Messaging / Writing Subheads and Body Copy
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MESSAGING  
BEST PRACTICES
When it comes to effective messaging, there 
are a few best practices to keep in mind and 
some watch-outs to avoid. 

Grab attention, and hold onto it. 
Our messaging should instantly grab our readers’ attention and  
leave them wanting to engage more. Use provocative questions, 
captivating insights or clever phrasing to set up your headlines or 
body-copy hooks, and use subsequent copy to answer or elaborate  
on these insights.  
 

Speak like a human. 
Make sure that language is relatable, conversational and excitable.  
Avoid clichés, marketing jargon and overly verbose or lofty language. 
 

Less is more. 
Headlines should be bite-sized but still pack a punch. Body copy 
shouldn’t be a chore to read. Keep language to the point and as  
brief but bold as possible. This may require rewording, reordering  
or finding new ways to articulate the same idea in a more  
effective way. 
 

Stay on-brand. 
Make sure that messaging is in line with the brand positioning, pillars 
and personality. A quick look at the "Strategy on a Page" section 
should give you a good idea if you’re heading in the right direction.

Find an interesting way in.
There are countless ways to talk about any topic. Explore unexpected 
and thought-provoking ways to shine a light on a subject or introduce 
an idea. 
 
EXAMPLES: 

Ask a provocative question.

Make a bold statement or fact that few 	  
people are aware of.  

Pair a scientific fact with an emotional 
mindset. 

Juxtapose big ideas or moments with 
smaller, intimate ones.  

Question the impossible and explore 
"what ifs." 

Let out the inner thoughts of a featured 
subject in the moment.

Brand Messaging / Messaging Best Practices
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AUDIENCE-
SPECIFIC 

MESSAGING
Headlines and supporting copy can be written to promote 
a general brand awareness or can be crafted to address a 
specific audience. In many cases, our messaging is tailored 
toward a specific audience, such as prospective or current 

students (undergraduate, graduate and/or executive), 
parents/family members, alumni, faculty, staff, donors, 

corporate partners and more. The following pages show 
examples of how the brand voice is used in general  

and for a few specific audiences. 

Brand Messaging / Audience-Specific Messaging
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EXAMPLE HEADLINES

You don't need permission to be great.  
A little help can’t hurt, though.

YES, you can land a job before you graduate.

YES, college can be more than worth it.

Open your eyes to unimaginable opportunities.  
Then jump in headfirst. 

YES, you can leave the stratosphere.

Give yourself a little more yes.

MESSAGING BY AUDIENCE: 

PROSPECTIVE  
STUDENTS
Craft language that excites prospective 
students about the opportunity of a college 
education at UA. Leverage optimistic 
language that both inspires and reassures 
students who are at the next step of their life 
journey. Speak about the many academic 
and cultural opportunities at UA.

Brand Messaging / Messaging by Audience / Prospective Students
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EXAMPLE HEADLINES

Can college really be affordable, accessible and  
worth it? Yes. Yes. Yes. 

How does a $63,806 starting salary sound?

Will my child get real, hands-on experience?  
Like, hands-on hands-on? Or an internship? Or both?  
Because the answer is still yes. 

MESSAGING BY AUDIENCE: 

PARENTS
For parent audiences, focus more on  
the importance and practicality of a  
college education and the many ways  
that UA opens the doors for their children,  
with hands-on education and internships, 
robust financial aid and our top-tier job- 
placement rate. Emphasize the ROI of a  
UA degree by highlighting outcomes  
and successful alumni. 

Brand Messaging / Messaging by Audience / Parents
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EXAMPLE HEADLINES

Made well in Akron. 

Take it from a city that can’t be stopped.

You don’t last 150 years by shooting big ideas down.  
Here’s to the next 150 years of YES.

Show the next generation what a little YES can do. 

MESSAGING BY AUDIENCE: 

ALUMNI & 
DONORS
For alumni and donors, it’s all about  
staying engaged. Find ways to speak to  
UA’s importance in the world and for  
future generations. Speak about the  
doors that UA opens and how alumni  
have shaped industry and culture. 

Brand Messaging / Messaging by Audience / Alumni & Donors
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EXAMPLE HEADLINES

When 180,000 Zips know you can, you can. 

YES, they will remember your name.

Do unbelievable things.

When a kangaroo from Northeast Ohio and 180,000  
alumni have your back, you’ll do great.

Limits are off-limits.

MESSAGING BY AUDIENCE: 

ATHLETICS
Go, Zips, go! For athletic messaging,  
leverage the optimism of “More Yes”  
with the excitement of D1 sports. And,  
of course, put the spotlight on Zippy. 

Brand Messaging / Messaging by Audience / Athletics
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VISUAL  
SYSTEM
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COLOR  
PALETTE

1
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BUCHTEL BLUE
RGB: 7 / 12 / 114 
HEX: #070c72 
CMYK: 100 / 100 / 0 / 20  
PMS: Pantone Reflex Blue

PREZI GOLD
RGB: 157 / 147 / 98 
HEX: #9d9362 
CMYK: 39 / 34 / 72 / 6  
PMS: 451

PRIMARY 
COLORS
These primary colors, and new additions 
Buchtel Blue and Prezi Gold, should be 
heavily featured on any piece of collateral 
produced by the University.

Be sure to use the appropriate color breaks 
for the output method. RGB and HEX codes 
are for digital use, while CMYK and PMS are 
for print use. Colors may appear differently 
from screen to print materials.

Please Note: This is an RGB document. All colors 
and swatches in this document will not print 
accurately.
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BLACK
RGB: 0 / 0 / 0 
HEX: #000000 
CMYK: 40 / 30 / 20 / 100  

BRIGHT BLUE
RGB: 30 / 99 / 175 
HEX: #1E63AF 
CMYK: 90 / 64 / 0 / 0  
PMS: 7684

WHITE
RGB: 255 / 255 / 255 
HEX: #ffffff 
CMYK: 0 / 0 / 0 / 0  

DAYLILY
RGB: 255 / 250 / 160 
HEX: #fffaa0 
CMYK: 0 / 0 / 45 / 0  
PMS: 917

SECONDARY 
COLORS
Secondary colors add flexibility to our color 
system and support the University's primary 
colors. These secondary colors should be 
reserved for use in subheads, statistics  
and small graphics.

Please Note: This is an RGB document. All colors 
and swatches in this document will not print 
accurately.

Visual System / Color Palette / Secondary Colors

KANGAROO BLUE
RGB: 35 / 35 / 255 
HEX: #2323ff 
DIGITAL COLOR ONLY
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TERTIARY 
COLORS
These tertiary colors should be reserved 
for small moments and used sparingly to 
introduce pops of color and excitement  
to highlight content, add movement or 
break up space.

Please Note: This is an RGB document. All colors 
and swatches in this document will not print 
accurately.

ZIPPY GREEN (DIGITAL)
RGB: 182 / 254 / 56 
HEX: #b6fe38 
CMYK: 32 / 0 / 100 / 0  
PMS: TBD

OHIO ORANGE
RGB: 255 / 71 / 10 
HEX: #ff470a 
CMYK: 4 / 90 / 100 / 1  
PMS: 485

BLOSSOM BLUE
RGB: 172 / 204 / 242 
HEX: #acccf2 
CMYK: 31 / 11 / 0 / 0  
PMS: 277

LUX YELLOW
RGB: 255 / 212 / 0 
HEX: #ffd400 
CMYK: 0 / 9 / 100 / 0  
PMS: 108

POLYMER PINK
RGB: 254 / 195 / 215 
HEX: #fec3d7 
CMYK: 2 / 26 / 6 / 0  
PMS: 2043

Visual System / Color Palette / Tertiary Colors

ZIPPY GREEN (PRINT)
CMYK: 24 / 0 / 88 / 0  
HEX: #b6fe38 
CMYK: 32 / 0 / 100 / 0  
PMS: TBD



The University of Akron Brand Guidelines 26

COLOR IN USE
Color proportions are key to ensuring that 
while we incorporate secondary colors 
into brand work, anything made by the 
University still feels recognizable as The 
University of Akron.

This is the preferred color proportion 
breakdown for all colors in the palette. 
While it is impossible to be exact with color 
proportions, this should serve as a basic 
guideline for using colors.

60%

25%

10%

<5%

Visual System / Color Palette / Color in Use
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COLOR 
ACCESSIBILITY
Color accessibility is key to creating a  
brand that is welcoming to all, regardless  
of abilities. Pairings of background colors 
and type colors ensure that our messaging 
is legible.

These are our preferred pairings of 
background color and type. While other 
pairings not shown here may be accessible, 
they are not recommended for brand use. 
Use only the color pairings featured on  
this page.

These leverage colors from all palettes,  
so make sure that you’re using them in 
context according to the color proportions  
outlined prior.

UNDERSTANDING THE LABELS
If a pairing is labeled with AA18, it should be used 
at large type sizes only (we recommend 18pt 
regular or 14pt bold, but no smaller). AAA and  
AA pairings can be used at any type size.

Visit the Contrast Grid

White (AAA) 
Daylily (AAA)
Prezi Gold (AA18) 
Zippy Green (AA18) 
Ohio Orange (AA) 
Polymer Pink (AAA) 
Blossom Blue (AAA) 
Lux Yellow (AAA)

White (AA18) 
Black (AA) 
Buchtel Blue (AA)

Buchtel Blue (AAA) 
Black (AAA) 
Kangaroo Blue (AA18)

White (AA18) 
Daylily (AA18)
Black (AA18)

White (AAA) 
Daylily (AAA)
Zippy Green (AA18) 
Polymer Pink (AA18) 
Blossom Blue (AA18) 
Lux Yellow (AA18)

Buchtel Blue (AAA) 
Black (AAA) 
Kangaroo Blue (AA18)

White (AAA) 
Daylily (AAA)
Prezi Gold (AA18) 
Zippy Green (AAA) 
Ohio Orange (AA18) 
Polymer Pink (AAA) 
Blossom Blue (AAA) 
Lux Yellow (AAA)

Buchtel Blue (AAA) 
Black (AAA) 
Kangaroo Blue (AA18)

White (AAA) 
Daylily (AAA  
Zippy Green (AA18) 
Polymer Pink (AA18) 
Blossom Blue (AA18) 
Lux Yellow (AA18)

Buchtel Blue (AAA) 
Bright Blue (AA18) 
Black (AAA) 
Kangaroo Blue (AA18)

Buchtel Blue (AAA) 
Black (AAA) 
Kangaroo Blue (AAA) 
Ohio Orange (AA18)

Buchtel Blue (AAA) 
Black (AAA) 
Kangaroo Blue (AAA) 
Ohio Orange (AA18)
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TYPOGRAPHY

2
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TYPEFACES

Open Sans

ALTIVO
Nicholas

APPROVED WEIGHTS

Altivo Extra Light
Altivo Regular 
Altivo Bold
Altivo Ultra

Altivo is big and bold, and should 
be used when creating impactful 
moments (headlines, breaker slides, 
pops of text).

APPROVED WEIGHTS

Nicholas Regular 
Nicholas Regular Italic 
Nicholas Semibold
Nicholas Bold
Nicholas Extra Bold

Nicholas is more elegant, academic 
and refined. It can be used in myriad 
ways, but works best in headlines, 
subheads or short blocks of copy.

APPROVED WEIGHTS

Open Sans Light 
Open Sans Regular
Open Sans Semibold
Open Sans Bold 
Open Sans Extrabold

Open Sans is fun and easy to digest. 
This useful font is primarily used as 
body copy, or little breadcrumbs  
and callouts.

Visual System / Typography / Typefaces

Altivo - Adobe Nicholas - Adobe Open Sans - Adobe Open Sans - Google

https://fonts.adobe.com/fonts/altivo
https://fonts.adobe.com/fonts/nicholas
https://fonts.adobe.com/fonts/open-sans
https://fonts.google.com/specimen/Open+Sans


The University of Akron Brand Guidelines 30

TYPE 
HIERARCHY
This is a basic type hierarchy that can be 
used as the baseline for a composition. 
Not only does it incorporate a mix of our 
brand fonts, but it also ensures a system of 
informational hierarchy that is necessary 
for our diverse audiences to visually 
differentiate messaging.

The specifications, like proportions, leading 
and tracking, should be seen as a starting 
point for typesetting, but can be adjusted 
based on compositional needs.

EYEBROWS ARE 1/6 OF HEADLINES

Subheads are about 2/5 of the  
cap-height of headlines and should 
look like this.

Body copy should be about 1/8 of the headline size. Based on readability factors 
such as size and color contrast, Open Sans can be used, but start with Regular. 
Body-copy size can vary based on collateral, but size for print should be between 
7-11 pts, and for web, between 12-16 px.

Captions should be smaller than body copy, but still legible. 
Start at 7 pts for print and 12 px for digital.

THIS IS A 
HEADLINE

Open Sans Extrabold
Tracking: 0 / Leading: 28 pt
All Caps
Left-aligned

Nicholas Regular
Tracking: -15 / Leading: 60 pt
Sentence Case
Left-aligned

Open Sans Regular
Tracking: -35 / Leading: 23 pt
Case Details
Alignment Details

Open Sans Extrabold
Tracking: -35 / Leading: 19 pt
Sentence Case
Left-aligned

Altivo Ultra
Tracking: -10 / Leading: 125 pt
All Caps
Left-aligned

Visual System / Typography / Type Hierarchy
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TYPE 
HIERARCHY
This is a basic type hierarchy that can be 
used as the baseline for a composition. 
Not only does it incorporate a mix of our 
brand fonts, but it also ensures a system of 
informational hierarchy that is necessary 
for our diverse audiences to visually 
differentiate messaging.

The specifications, like proportions, leading 
and tracking, should be seen as a starting 
point for typesetting, but can be adjusted 
based on compositional needs.

EYEBROWS ARE 1/7 OF HEADLINES

SUBHEADS ARE ABOUT  
2/5 OF THE CAP-HEIGHT OF 
HEADLINES AND SHOULD 
LOOK LIKE THIS.
Body copy should be about 1/9 of the headline size. Based on readability factors 
such as size and color contrast, Open Sans can be used, but start with Regular. 
Body-copy size can vary based on collateral, but size for print should be between 
7-11 pts, and for web, between 12-16 px.

Captions should be smaller than body copy, but still legible. 
Start at 7 pts for print and 12 px for digital.

This is a  
headline.

Open Sans Extrabold
Tracking: 0 / Leading: 28 pt
All Caps
Left-aligned

Altivo Extra Light
Tracking: -15 / Leading: 50 pt
All Caps
Left-aligned

Open Sans Regular
Tracking: -35 / Leading: 23 pt
Case Details
Alignment Details

Open Sans Extrabold
Tracking: -35 / Leading: 19 pt
Sentence Case
Left-aligned

Visual System / Typography / Type Hierarchy

Nicholas Regular and Extra Bold
Tracking: -15 / Leading: 140 pt
Sentence Case
Left-aligned



The University of Akron Brand Guidelines 32

STYLIZED 
HEADLINE
A staggered headline style based on The 
University of Akron logo. When using this 
format, always use start case (first letter of 
each word capitalized, regardless of part of 
speech). This style works best for shorter 
copy that can lay on 3 to 5 staggering lines.

Visual System / Typography / Stylized Headline
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DESIGN  
ELEMENTS

3
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OUTLINED 
STICKER TYPE
This sticker move gives our staggered  
type flexibility to sit on any color, pattern  
or photograph.

HOW TO: 
(1) Create a new file in Illustrator

(2) Arrange the type in the desired layout

(3) �Select the type and create outlines  
(Type > Create Outlines)

(4) �Unite outlined type (Window >  
Pathfinder > Unite) while holding  
down the Option key (Mac)

(5) �Offset the path (Object > Path >  
Offset Path) with the following settings: 
Offset: 25 px, Joins: Round and Miter 
limit: 4 (Please note: settings may vary 
based on size of object being outlined.)

(6) Change colors (if needed)

(7) Save the file

(8) Apply to the design

1 2

3 4
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REVERBERATING 
COLLAGE (MITER)
This move allows us to capture the energy, 
the diversity and the many colorful 
moments that our campus and history 
have to offer by layering photography and 
textures to create a branded collage.

HOW TO: 
(1) Create a new file in Illustrator

(2) �Create the item you want to turn into  
a collage

(3) �Select the item and expand (Object > 
Expand). If multiple parts, ungroup and 
then unite (Window > Pathfinder > Unite)

(4) �Offset the path (Object > Path > Offset 
Path) with the following settings: Offset: 
25-100 px (depending on size of item), 
Joins: Miter and Miter limit: 4

(5) �Add colors, textures, photography, etc.  
to create the collage effect

(6) Save the file

(7) Apply to the design

1 2

3 4
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REVERBERATING 
COLLAGE 
(ROUND)
Using the sticker type move as our base, 
we can bring flexibility to our reverberating 
collage move to accentuate a word or  
short phrase.

HOW TO: 
(1) Create a new file in Illustrator

(2) �Create the item you want to turn into  
a collage

(3) �Select the item and expand (Object > 
Expand). If multiple parts, ungroup and 
then unite (Window > Pathfinder > Unite)

(4) �Offset the path (Object > Path > Offset 
Path) with the following settings: Offset: 
25-100 px (depending on size of item), 
Joins: Round and Miter limit: 4

(5) �Add colors, textures, photography, etc.  
to create the collage effect

(6) Save the file

(7) Apply to the design

1 2

3 4
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DUOTONE GRIT
This move produces a striking visual style 
that gives imagery a down-to-earth and 
hands-on and edgy feel that speaks to the 
drive that our students and faculty have.

HOW TO: 
(1) Open the Duotone Grit Effect file

(2) �Double-click the "Place Image Here" layer 
and place the photo you want to effect 
into the .psd file

(3) �Save the file and click on the .psd file

(4) �Apply the desired gradient (adjust sliders 
as need based on effect photograph)
and apply Brightness/Contrast layer (if 
needed)

(5) Save the file

(6) Apply to the design

1 2

3 4
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ZIP, ZIPS AND 
YES SHAPES
These containers are designed with key 
phrases and words in mind. YES, ZIP and 
ZIPS are outlined in a variety of ways to 
contain a variety of content in a uniquely  
UA way.

Please Note: The letter "S" should never 
be stretched.
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AKRON 
PATTERNS
Patterns are a great way to activate negative 
space and bring a sense of pride, history or 
movement to a piece. Each of these patterns 
is inspired from moments on campus or 
in history.
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KANGA
Use these Kangas as a stamp and design 
element to activate negative space and inject 
an element of UA pride into any piece.
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AKRON SHIELD
Here, we use the outline of the UA Shield as  
a design element to bring a quickly “gettable” 
icon into the toolkit. This can help anchor 
text, act as a text counter or be used as a 
simple design element. 
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PHOTOGRAPHY
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PHOTOGRAPHY 
OVERVIEW
Whether you’re shooting new photography 
or using imagery from UA’s expansive photo 
library, there are a few things to keep in mind 
when capturing or sourcing images:

• Photography is an opportunity to 
naturally introduce secondary colors to a 
design. Look for blues and yellows to 
add visual interest and contrast

• To keep images authentic, excessive 
editing or manipulation of images is 
strongly discouraged

• Be sure to showcase the diverse body of 
the University of Akron's students, 
alumni and faculty by ensuring that a 
balance of genders, races and ethnicities 
is represented in photos

• Keep brand personality words 
Confident,	Industrious,	Committed, 
Intentional and Genuine top of mind

PORTRAITURE

IN ACTION

ON CAMPUS

ARCHIVAL
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PORTRAITURE
 DO
•	 Show a range of ages and backgrounds

•	 Use warm, natural lighting

•	 Evoke a sense of expressive action 
with candids balanced with authentic 
portraiture

•	 Allow backgrounds and props to add 
contextual information about the 
subject’s passions

  DON’T
•	 Have staged or overly posed images

•	 Use strong, artificial light

Visual System / Photography / Portraiture
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ON CAMPUS
 DO
•	 Showcase campus in all seasons

•	 Mix campus beauty shots with those  
that showcase the vibrancy of campus 
when students are present

•	 Ensure that colors that are shown are 
accurate to reality

•	 Look for interesting compositions, 
including aerial and ground photography, 
close-ups and wide shots

•	 Seek out images that showcase the 
interaction of our campus with the 
environment around us

  DON’T
•	 Utilize stock imagery to represent the 

University of Akron's campus

•	 Include photos with too many distracting 
elements

Visual System / Photography / On Campus
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IN ACTION
 DO
•	 Showcase real The University of Akron 
students, faculty and staff doing work 
in their field, volunteering or learning

•	 Capture the moments of doing with 
candid shots featuring movement

•	 Balance portraits with textural shots

•	 Show various means of action 
representative of our community, 
including, for example, research, dance, 
painting, building, etc.

•	 Look for interesting compositions that 
introduce new viewpoints of action

  DON’T
•	 Have staged moments of action

•	 Use artificial light

•	 Recolor/retouch images in ways that 
lose their authenticity

Visual System / Photography / In Action
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ARCHIVAL
 DO
•	 Seek out images that showcase 

the University of Akron's rich and 
vibrant history, demonstrating the 
longstanding values of the University

•	 Show a range of ages and backgrounds

•	 Use as a secondary photo to anchor a 
piece in the history of the University

  DON’T
•	 Use low-quality scans of archival photos

Visual System / Photography / Archival
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IN  
APPLICATION
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Questions?
If you need assistance or have questions 
regarding the More Yes brand and how 
it relates to other University communication 
and branding, please contact:

ucm@uakron.edu


